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Introduction

An échelle spectrograph is capable of capturing the spectrum of a source over a large 
wavelength range at high resolving powers. Typical resolving powers would be R = λ/Δλ 
>> 10,000, where is Δλ a single resolution element centered on the wavelength λ. The 2-
dimensional échelle spectral format (Figure 1) permits a very large spectral grasp. Visible 
light instruments are capable of covering the entire visible spectrum in a single exposure. 
High resolution échelle spectrographs are commonly used in astronomy for the analysis of 
stellar atmospheres and for precision Doppler velocimetry. Laboratory based instruments 
can be used for applications such as high throughput Raman spectroscopy.

Figure 1: An example of a 2-dimensional échelle spectrum. The direction of échelle dispersion 
(short to long wavelengths) is left to right, and the cross-dispersion runs from bottom to top.

For an overview of the properties of échelle spectrographs see Ref. 1. This tutorial 
simulates an asymmetric ‘white pupil’ form of this instrument (Ref. 2). It makes use of 
several parts from the COMSOL Part Library and demonstrates the creation of a complex, 
fully parameterized geometry. Two Grating components are included, and two different 
uses of the Diffraction Order node are demonstrated.

In this simulation, the choice has been made to Use relative order numbers (Δm) for the 
échelle grating. The absolute order number (m) will then be computed automatically 
based on the grating geometry and the specified blaze angle (θB). That is,
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,

where n1 is the incident refractive index for the wavelength λ0 and d is the grating line 
spacing. The in-plane and out-of-plane angles γ and θ = α - θB, are determined from the 
grating geometry and the properties of the incident ray. That is,

,

and

,

where kn = k · ns is the component of the incoming wave vector k in the direction of the 
grating normal ns, and kp,in and kp,out are the in-plane and out-of-plane components of 
the wave vector projected onto the grating surface (kp). That is,

,

and

,

where Tg is a unit vector on the grating surface pointing in the direction of periodicity.

Model Definition

In order to simplify the creation of the model, the instrument geometry is created 
separately. The spectrograph parameters are therefore split between those required to 
create the geometry, and those that will be used to set up and complete the ray tracing 
simulation. In Table 1 the échelle spectrograph geometry parameters are given. These 
parameters are grouped in the Parameters 1: Geometry node together with the camera 
optical prescription. Note that a parameter can be given either as a numeric value, or as an 
expression in terms of other parameters. The ability to define parameters as expressions is 
used extensively when creating the parameterized geometry sequence.

Detailed instructions for creating the geometry can be found in Appendix — Geometry 
Instructions. The spectrograph model incorporates a camera objective from another 
COMSOL Application Library example. Refer to the document Petzval Lens for further 
details.

m round
2n1d

λ0
-------------- γ θB θcossincos 
  Δm+=

θ
kp in,

kn
------------- 
 atan– θB–=

γ
kp out, θBcos

kn
-------------------------------- 
 atan–=

kp in, kp Tg⋅=

kp out, kp ns T× g( )⋅=
3 |  W H I T E  P U P I L  É C H E L L E  S P E C T R O G R A P H



TABLE 1:  WHITE PUPIL ECHELLE SPECTROGRAPH GEOMETRY PARAMETERS.

Parameter Expression Value Description

B — 100.0 mm Collimated beam diameter

dmag — 2.0 White pupil demagnification constant

f1 — 800.0 mm Primary mirror focal length

f2 f1/dmag 400.0 mm Secondary mirror focal length

fclear — 0.95 Mirror clear aperture fraction

d0,OAP,1 — 185.0 mm Full diameter of primary mirror

dc,OAP,1 175.8 mm Clear diameter of primary mirror

Tc,OAP,1 30.8 mm Center thickness of primary mirror

d0,OAP,2 — 125.0 mm Full diameter of secondary mirror

dc,OAP,2 118.8 mm Clear diameter of secondary mirror

Tc,OAP,2 20.8 mm Center thickness of secondary mirror

θi — 7.5° Off axis paraboloid angle

dx,1 105.3 mm Entrance pupil off axis distance

dx,2 52.7 mm Exit pupil off axis distance

dx,1,nom 123.5 Primary mirror off axis distance

dx,2,nom 34.5 mm Secondary mirror off axis distance

Rnum — 4.0 Échelle grating “R-number”

θB 75.96° Échelle grating blaze angle

γech — -0.65° Échelle grating out of plane angle

Wech 1.05 × B 105.0 mm Échelle grating width

Dech 420.0 mm Échelle grating depth

Hech 42.0 mm Échelle grating height

λxdp — 525.0 nm Cross disp. grating central wavelength

Txdp — 725.0 /mm Cross disp. grating line frequency

σxdp 1.379 μm Cross disp. grating line spacing

θxdp 10.97° Cross disp. grating blaze angle

Wxdp 1.50 × B/dmag 75.0 mm Cross disp. grating width

Dxdp 1.25 × B/dmag 62.5 mm Cross disp. grating depth

Hxdp 7.5 mm Cross disp. grating height

Zxdp — -75.0 Cross disp. grating displacement

fclear d× 0 OAP 1, ,
d0 OAP 1, , 6⁄

fclear d× 0 OAP 2, ,
d0 OAP 2, , 6⁄

f1 θitan

f2 θitan

dx 1, f1 2γech( )tan–

dx 2, f1 2γech( )tan+

Rnum( )atan

Rnum Wech×

Dech 10⁄

1 Txdp⁄

λxdp 2 σxdp×( )⁄( )asin

Wxdp 10⁄
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Table 2 lists the remaining model parameters. These are found in the Parameters 2: General 
node. As noted above, the échelle Grating feature is set to Use relative order numbers. 
Therefore, the polychromatic wavelength distribution can be specified using a List of values 
without needing to also specify the diffraction order number. This is done in the Vacuum 

Wavelength section of the Release from Point feature. The list can span any wavelength 
range. The absolute order for a given wavelength will be computed such that it is within 
the free spectral range centered on the blaze wavelength for that order.1

1. Note that this model uses three release features for convenience only. That is, this limits the complexity of the
expression that is placed in the List of values.

TABLE 2:  WHITE PUPIL ECHELLE SPECTROGRAPH MODEL PARAMETERS.

Parameter Expression Value Description

Nhex — 10 Number of hexapolar rings per 
wavelength

Input optical axis definitions:

xi 0.130526 Input optical axis, x-component

yi — 0 Input optical axis, y-component

zi 0.991449 Input optical axis, z-component

F 8.0 Input focal ratio

NA 0.5/F 0.0625 Input numerical aperture

Remaining échelle grating definitions:

Tech — 31.6 /mm Échelle grating line frequency

σech 31.646 μm Échelle grating line spacing

Wavelength and order definitions:

mλ 61,397.473 nm Order number times wavelength

λmin — 450.0 nm Nominal minimum wavelength

λmax — 600.0 nm Nominal maximum wavelength

mmax 136 Maximum order number

mmin 102 Minimum order number

mmid 117 Middle order number

θisin

θicos

f1 B⁄

1 Tech⁄

2σech γech θBsincos

round mλ λmin⁄( )

round mλ λmax⁄( )

mmax mmin+( ) 2⁄ 2+
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Results and Discussion

The full geometry sequence (including the scaled Petzval Lens) can be seen in Figure 2. 
As noted above, the spectrograph geometry is fully parameterized, and hence the model 
can be adjusted using the globally defined parameters.

Figure 2: The White Pupil Échelle Spectrograph geometry sequence.

In this simulation, a ray trace is performed over three échelle orders, with 5 wavelengths 
in each order. The resulting ray diagrams can be seen in Figure 3 and Figure 4. In these 
ray traces only the marginal rays are traced from the entrance slit. This allows the 
spectrograph’s geometry (including clear aperture parameters) to be verified.

In Figure 5 the location of each wavelength on the image plane is plotted. This “échelle 
diagram” can in principle be extended to include as many wavelengths and orders as 
necessary.

The monochromatic spot diagrams can be seen in Figure 6. Note that the objective lens 
has not been fully optimized to account for the cylindrical field curvature that is present 
in a spectrograph of this type.
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Figure 3: The white pupil échelle spectrograph ray diagram plane view.

Figure 4: The white pupil échelle spectrograph ray diagram 3D view.
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Figure 5: The échelle diagram. The primary (échelle) dispersion runs from right to left, while 
the cross-dispersion direction goes from bottom to top.

Figure 6: A spot diagram for the échelle spectrograph.
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Application Library path: Ray_Optics_Module/
Spectrometers_and_Monochromators/white_pupil_echelle_spectrograph

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop).

3 Click Add.

4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.

6 Click Done.

G L O B A L  D E F I N I T I O N S

Load the global parameters for the échelle spectrograph from a text file. Additional 
parameters will be added when the geometry sequence is inserted in the following section.

Parameters 1: Geometry
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Geometry in the Label text 
field.

Parameters 2: General
1 In the Home toolbar, click Parameters and choose Add>Parameters.
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2 In the Settings window for Parameters, type Parameters 2: General in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
white_pupil_echelle_spectrograph_params.txt.

C O M P O N E N T  1  ( C O M P 1 )

1 In the Model Builder window, click Component 1 (comp1).

2 In the Settings window for Component, locate the General section.

3 Find the Mesh frame coordinates subsection. From the Geometry shape function list, 
choose Cubic Lagrange. The ray tracing algorithm used by the Geometrical Optics 
interface computes the refracted ray direction based on a discretized geometry via the 
underlying finite element mesh. A cubic geometry shape order would usually introduce 
less discretization error compared to quadratic.

W H I T E  P U P I L  É C H E L L E  S P E C T R O G R A P H  G E O M E T R Y  S E Q U E N C E

Insert the prepared geometry sequence from file. You can read the instructions for creating 
the geometry in the appendix. Following insertion, the full set of parameter definitions will 
be available in the Parameters node.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type White Pupil Échelle Spectrograph 
Geometry Sequence in the Label text field.

3 In the Geometry toolbar, click Insert Sequence.

4 Browse to the model’s Application Libraries folder and double-click the file 
white_pupil_echelle_spectrograph_geom_sequence.mph.

5 In the Insert Sequence from File dialog box, click OK.

6 Right-click Component 1 (comp1)>White Pupil Échelle Spectrograph Geometry Sequence 
and choose Build All Objects.

7 Click the Orthographic Projection button in the Graphics toolbar.

8 Click the Go to ZX View button in the Graphics toolbar.

9 Click the Zoom Extents button in the Graphics toolbar. Orient the view to place the 
z-axis (optical axis) horizontal and the y-axis vertical. Compare the resulting geometry 
to Figure 2.
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A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Optical>Glasses>Optical Glass: Schott>Schott N-BK7®.

4 Click Add to Component in the window toolbar.

5 In the tree, select Optical>Glasses>Optical Glass: Ohara>Ohara S-BAH32.

6 Click Add to Component in the window toolbar.

7 In the tree, select Optical>Glasses>Optical Glass: Schott>Schott N-SK2.

8 Click Add to Component in the window toolbar.

9 In the tree, select Optical>Glasses>Optical Glass: Schott>Schott N-SF5.

10 Click Add to Component in the window toolbar.

11 In the tree, select Built-in>Silica glass.

12 Click Add to Component in the window toolbar.

13 In the Home toolbar, click Add Material to close the Add Material window.

M A T E R I A L S

Schott N-BK7® (mat1)
1 In the Model Builder window, under Component 1 (comp1)>Materials click Schott N-

BK7® (mat1).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 1.

Ohara S-BAH32 (mat2)
1 In the Model Builder window, click Ohara S-BAH32 (mat2).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 2.

Schott N-SK2 (mat3)
1 In the Model Builder window, click Schott N-SK2 (mat3).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Lens Material 3.

Schott N-SF5 (mat4)
1 In the Model Builder window, click Schott N-SF5 (mat4).

2 In the Settings window for Material, locate the Geometric Entity Selection section.
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3 From the Selection list, choose Lens Material 4.

Silica glass (mat5)
1 In the Model Builder window, click Silica glass (mat5).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Grating Material.

G E O M E T R I C A L  O P T I C S  ( G O P )

1 In the Model Builder window, under Component 1 (comp1) click Geometrical Optics (gop).

2 In the Settings window for Geometrical Optics, locate the Domain Selection section.

3 From the Selection list, choose All Refracting. The refracting elements were selected 
when the geometry sequence was created.

4 Locate the Ray Release and Propagation section. From the 
Wavelength distribution of released rays list, choose Polychromatic,

specify vacuum wavelength.

5 In the Maximum number of secondary rays text field, type 0.

6 Select the Use geometry normals for ray-boundary interactions check box. In this 
simulation, the geometry normals are used to apply the boundary conditions on all 
refracting surfaces. This is appropriate for the highest accuracy ray traces in single-
physics simulations, where the geometry is not deformed.

7 Locate the Material Properties of Exterior and Unmeshed Domains section. From the 
Optical dispersion model list, choose Absolute vacuum. In this simulation we assume that 
the spectrograph is entirely in vacuum.

The following variables are used during postprocessing.

8 Locate the Additional Variables section. Select the Compute optical path length check 
box.

9 Select the Count reflections check box.

10 Select the Store ray status data check box.

Medium Properties 1
1 In the Model Builder window, under Component 1 (comp1)>Geometrical Optics (gop) click 

Medium Properties 1.

2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the Refractive index of domains list, choose Get dispersion model from material.

Material Discontinuity 1
1 In the Model Builder window, click Material Discontinuity 1.
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2 In the Settings window for Material Discontinuity, locate the Rays to Release section.

3 From the Release reflected rays list, choose Never. In this tutorial stray light is not being 
traced, so reflected rays will not be produced at any refracting surfaces.

Release From Entrance Slit: m_max
1 In the Physics toolbar, click Points and choose Release from Point.

2 In the Settings window for Release from Point, type Release From Entrance Slit: 
m_max in the Label text field.

3 Locate the Point Selection section. From the Selection list, choose Entrance Point.

4 Locate the Ray Direction Vector section. From the Ray direction vector list, choose 
Conical.

5 From the Conical distribution list, choose Hexapolar.

6 In the Nθ text field, type N_hex. With N_hex=10 331 rays will be released for each 
wavelength.

7 Specify the r vector as

8 In the α text field, type atan(NA). This is the half angle subtended by the numerical 
aperture (NA).

9 Locate the Vacuum Wavelength section. From the Distribution function list, choose 
List of values.

10 In the Values text field, type mlam/(m_max+0.499) mlam/(m_max+0.25) mlam/m_max 
mlam/(m_max-0.25) mlam/(m_max-0.499). These wavelengths are all found in order 
m_max. The release is duplicated below so that wavelengths from other orders can be 
more easily added. Because the grating feature uses relative order numbers, a ray trace 
over all wavelengths and order numbers can be performed in a single study.

Release From Entrance Slit: m_mid
1 Right-click Release From Entrance Slit: m_max and choose Duplicate.

2 In the Settings window for Release from Point, type Release From Entrance Slit: 
m_mid in the Label text field.

3 Locate the Vacuum Wavelength section. In the Values text field, type mlam/(m_mid+
0.499) mlam/(m_mid+0.25) mlam/m_mid mlam/(m_mid-0.25) mlam/(m_mid-

0.499).

xi x

yi y

zi z
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Release From Entrance Slit: m_min
1 Right-click Release From Entrance Slit: m_mid and choose Duplicate.

2 In the Settings window for Release from Point, type Release From Entrance Slit: 
m_min in the Label text field.

3 Locate the Vacuum Wavelength section. In the Values text field, type mlam/(m_min+
0.495) mlam/(m_min+0.25) mlam/m_min mlam/(m_min-0.25) mlam/(m_min-

0.495).

Mirrors
1 In the Physics toolbar, click Boundaries and choose Mirror.

2 In the Settings window for Mirror, type Mirrors in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Mirrors.

Obstructions (Gratings and Mirrors)
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions (Gratings and Mirrors) in the 
Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose 
Obstructions (Gratings and Mirrors).

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Obstructions (Camera)
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions (Camera) in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.

4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.

Échelle Grating
Define the échelle grating properties.

1 In the Physics toolbar, click Boundaries and choose Grating.

2 In the Settings window for Grating, type Échelle Grating in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose 
Grating Surface (Échelle Grating).

4 Locate the Grating Orientation section. From the Direction of periodicity list, choose 
Parallel to reference edge.
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5 Locate the Reference Edge Selection section. Select the Activate Selection toggle 
button.

6 Select Edge 182 only.

7 Locate the Device Properties section. Select the Use relative order numbers check box. 
The absolute order number will be computed automatically such that the wavelengths 
are diffracted within the blaze envelope.

8 From the Rays to release list, choose Reflected.

9 In the d text field, type sigma_ech.

10 In the θB text field, type theta_B.

Cross Dispersion Grating
Define the cross dispersion grating properties.

1 In the Physics toolbar, click Boundaries and choose Grating.

2 In the Settings window for Grating, type Cross Dispersion Grating in the Label text 
field.

3 Locate the Boundary Selection section. From the Selection list, choose 
Grating Surface (Cross Dispersion Grating Entrance).

4 Locate the Grating Orientation section. From the Direction of periodicity list, choose 
Parallel to reference edge.

5 Locate the Reference Edge Selection section. Select the Activate Selection toggle 
button.

6 Select Edge 117 only.

7 Locate the Device Properties section. From the Rays to release list, choose Transmitted.

8 In the d text field, type sigma_xdp.

Diffraction Order (m = 0)
1 In the Model Builder window, expand the Cross Dispersion Grating node, then click 

Diffraction Order (m = 0).

2 In the Settings window for Diffraction Order, locate the Device Properties section.

3 In the m text field, type 1. The cross dispersion grating is used in first order only.

Detector
1 In the Physics toolbar, click Boundaries and choose Wall.

2 In the Settings window for Wall, type Detector in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose All (Image).
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D E F I N I T I O N S

Union 1
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, in the Selections to add list, choose Lens Exteriors, 
Exterior (Cross Dispersion Grating Entrance), and Exterior (Cross Dispersion Grating Exit).

6 Click OK.

Union 2
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, locate the Geometric Entity Level section.

3 From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog box, in the Selections to add list, choose Mirrors and 
Grating Surface (Échelle Grating).

6 Click OK.

M E S H  1

Adjust the default mesh to improve the ray tracing accuracy.

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Extremely fine.

4 Click Build All.

S T U D Y  1

Step 1: Ray Tracing
1 In the Model Builder window, under Study 1 click Step 1: Ray Tracing.

2 In the Settings window for Ray Tracing, locate the Study Settings section.

3 From the Time-step specification list, choose Specify maximum path length.

4 From the Length unit list, choose mm.

5 In the Lengths text field, type 0 5000. This path length is sufficient for all rays to reach 
the image plane.
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6 In the Home toolbar, click Compute.

R E S U L T S

Ray Diagram
In the following steps, a ray diagram is created with the rays colored according to 
wavelength. A surface plot is added to render the optical elements as opaque surfaces.

Ray Diagram
1 In the Model Builder window, under Results click Ray Trajectories (gop).

2 In the Settings window for 3D Plot Group, type Ray Diagram in the Label text field. The 
surface plot will be used to render the optical elements.

3 Locate the Color Legend section. Select the Show units check box.

4 Select the Show maximum and minimum values check box.

5 From the Position list, choose Bottom.

6 Click to expand the Number Format section. Select the Manual color legend settings check 
box.

7 In the Precision text field, type 4.

Ray Trajectories 1
1 In the Model Builder window, expand the Ray Diagram node, then click Ray Trajectories 1.

2 In the Settings window for Ray Trajectories, locate the Extra Time Steps section.

3 From the Maximum number of extra time steps rendered list, choose All.

Color Expression 1
1 In the Model Builder window, expand the Ray Trajectories 1 node, then click 

Color Expression 1.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.lambda0.

4 From the Unit list, choose nm.

5 Locate the Coloring and Style section. From the Color table list, choose Spectrum.

Filter 1
1 In the Model Builder window, click Filter 1.

2 In the Settings window for Filter, locate the Ray Selection section.

3 From the Rays to include list, choose Logical expression.
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4 In the Logical expression for inclusion text field, type at(0,tan(gop.phic))>0.95*NA. 
This will cause only the marginal rays to be rendered.

Surface 1
1 In the Model Builder window, right-click Ray Diagram and choose Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Coloring list, choose Uniform.

4 From the Color list, choose Gray.

Selection 1
1 Right-click Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Obstructions (Gratings and Mirrors).

Transparency 1
In the Model Builder window, right-click Surface 1 and choose Transparency.

Surface 2
1 Right-click Surface 1 and choose Duplicate.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color list, choose Blue.

Selection 1
1 In the Model Builder window, expand the Surface 2 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Union 1.

Transparency 1
1 In the Model Builder window, click Transparency 1.

2 In the Settings window for Transparency, locate the Transparency section.

3 In the Transparency text field, type 0.8.

Surface 3
1 In the Model Builder window, under Results>Ray Diagram right-click Surface 2 and 

choose Duplicate.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Color list, choose Custom.
18 |  W H I T E  P U P I L  É C H E L L E  S P E C T R O G R A P H



4 On Windows, click the colored bar underneath, or — if you are running the cross-
platform desktop — the Color button.

5 Click Define custom colors.

6 Set the RGB values to 189, 201, and 216, respectively.

7 Click Add to custom colors.

8 Click Show color palette only or OK on the cross-platform desktop.

Selection 1
1 In the Model Builder window, expand the Surface 3 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Union 2.

Transparency 1
1 In the Model Builder window, click Transparency 1.

2 In the Settings window for Transparency, locate the Transparency section.

3 In the Transparency text field, type 0.2.

4 In the Ray Diagram toolbar, click Plot.

5 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 3. Orient the view to match Figure 4 to show the all the rays.

Échelle Diagram
In the following steps, an échelle diagram is created showing the ray positions in the image 
plane.

Échelle Diagram
1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Échelle Diagram in the Label text field.

3 Click to expand the Title section. From the Title type list, choose None.

4 Locate the Color Legend section. Select the Show maximum and minimum values check 
box.

5 Select the Show units check box.

6 From the Position list, choose Bottom.

7 Click to expand the Number Format section. Select the Manual color legend settings check 
box.

8 In the Precision text field, type 4.
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Spot Diagram 1
1 In the Échelle Diagram toolbar, click More Plots and choose Spot Diagram.

2 In the Settings window for Spot Diagram, locate the Filters section.

3 Select the Filter by number of reflections check box.

4 In the associated text field, type 4.

5 Click to expand the Focal Plane Orientation section. From the Transverse direction list, 
choose User defined.

6 In the x text field, type 0.

7 In the y text field, type 1.

8 Locate the Layout section. From the Spot arrangement list, choose Single plot.

9 Click to expand the Annotations section. Clear the Show spot size check box.

10 Locate the Coloring and Style section. Select the Radius scale factor check box.

Color Expression 1
1 Right-click Spot Diagram 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type gop.lambda0.

4 In the Échelle Diagram toolbar, click Plot.

5 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 5.

Spot Diagram
Next, create use the Spot Diagram to show the monochromatic spots on the image plane.

Spot Diagram
1 In the Home toolbar, click Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show maximum and minimum values check 
box.

4 From the Position list, choose Bottom.

5 Locate the Number Format section. Select the Manual color legend settings check box.

6 In the Precision text field, type 4.

Spot Diagram 1
1 In the Spot Diagram toolbar, click More Plots and choose Spot Diagram.

2 In the Settings window for Spot Diagram, locate the Filters section.
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3 Select the Filter by number of reflections check box.

4 In the associated text field, type 4.

5 Locate the Layout section. From the Spot arrangement list, choose Sort by wavelength.

6 From the Layout list, choose Rectangular grid.

7 In the Number of columns text field, type 5.

8 In the Tolerance text field, type 0.1[nm].

9 From the Origin location list, choose Average over area.

10 Locate the Annotations section. Select the Show wavelength check box.

11 In the Display precision text field, type 5.

Color Expression 1
1 Right-click Spot Diagram 1 and choose Color Expression.

2 In the Settings window for Color Expression, locate the Expression section.

3 In the Expression text field, type at(0,tan(gop.phic)). This is the numerical aperture 
at which each ray is released.

4 In the Spot Diagram toolbar, click Plot.

5 Click the Show Grid button in the Graphics toolbar.

6 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting 
image to Figure 6.

Appendix — Geometry Instructions

The geometry of the white pupil échelle spectrograph includes the camera lens included 
in the COMSOL Application Library. Details of this model may be found in the document 
Petzval Lens.

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 Click Done.
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G L O B A L  D E F I N I T I O N S

The parameters used to define the échelle spectrograph geometry can be loaded from a 
file.

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
white_pupil_echelle_spectrograph_geom_sequence_params.txt.

G E O M E T R Y  1

Click the Orthographic Projection button in the Graphics toolbar.

G L O B A L  D E F I N I T I O N S

In the Model Builder window, right-click Global Definitions and choose Geometry Parts>

Part Libraries.

P A R T  L I B R A R I E S

1 In the Part Libraries window, select Ray Optics Module>3D>Mirrors>

conic_mirror_off_axis_3d in the tree.

2 Click Add to Model. This part is used for the primary and secondary mirrors within 
the white pupil relay.

3 In the Select Part Variant dialog box, select 
Specify clear aperture diameter and off axis distance in the Select part variant list.

4 Click OK.

Create a part to be used to define the diffraction gratings. This part includes selections that 
can be used in the final model to define the Grating properties.

G R A T I N G

1 In the Model Builder window, under Global Definitions right-click Geometry Parts and 
choose 3D Part.

2 In the Settings window for Part, type Grating in the Label text field.
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3 Locate the Input Parameters section. In the table, enter the following settings:

Block 1 (blk1)
1 In the Geometry toolbar, click Block.

2 In the Settings window for Block, locate the Size and Shape section.

3 In the Width text field, type W.

4 In the Depth text field, type D.

5 In the Height text field, type H.

6 Locate the Position section. From the Base list, choose Center.

7 In the z text field, type -H/2.

All
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type All in the Label text field.

3 Select the object blk1 only.

Exterior
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Exterior in the Label text field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 Select the object blk1 only.

Grating Surface
1 In the Geometry toolbar, click Selections and choose Explicit Selection.

2 In the Settings window for Explicit Selection, type Grating Surface in the Label text 
field.

3 Locate the Entities to Select section. From the Geometric entity level list, choose 
Boundary.

4 On the object blk1, select Boundary 4 only.

Name Default expression Value Description

W 50[mm] 0.05 m Grating Width

D 75[mm] 0.075 m Grating Depth

H 10[mm] 0.01 m Grating Height
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Grating Obstruction
1 In the Geometry toolbar, click Selections and choose Difference Selection.

2 In the Settings window for Difference Selection, type Grating Obstruction in the Label 
text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Click Add.

5 In the Add dialog box, select Exterior in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference Selection, locate the Input Entities section.

8 Click Add.

9 In the Add dialog box, select Grating Surface in the Selections to subtract list.

10 Click OK.

W H I T E  P U P I L  É C H E L L E  G E O M E T R Y  S E Q U E N C E

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, type White Pupil Échelle Geometry 
Sequence in the Label text field.

3 Locate the Units section. From the Length unit list, choose mm.

Entrance Point
Start constructing the spectrograph geometry. First, create Work Planes to define the 
relationship between the various optical elements.

1 In the Geometry toolbar, click More Primitives and choose Point.

2 In the Settings window for Point, type Entrance Point in the Label text field.

3 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
check box. By default the entrance slit will be located at the origin.

Échelle Grating
The échelle grating position is defined using several work planes.

Pre Gamma Échelle Facet Tangent Plane
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Pre Gamma Échelle Facet Tangent 
Plane in the Label text field.

3 Click to expand the Local Coordinate System section. Locate the Plane Definition section. 
From the Plane type list, choose Transformed.
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4 Find the Displacement subsection. In the xw text field, type dx_1.

5 Find the Rotation subsection. From the Axis type list, choose xw-axis.

6 In the Rotation angle text field, type 90[deg]. This plane is only required to allow the 
correct interpretation of the subsequent gamma_ech angle.

Post Gamma Échelle Facet Tangent Plane
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Post Gamma Échelle Facet Tangent 
Plane in the Label text field.

3 Locate the Plane Definition section. From the Plane type list, choose Transformed.

4 From the Work plane to transform list, choose 
Pre Gamma Échelle Facet Tangent Plane (wp1).

5 Find the Rotation subsection. In the Rotation angle text field, type gamma_ech. This is 
the "out of plane" angle to ensure that the "intermediate slit" (formed after the second 
reflection from the primary mirror) is displaced from the entrance slit.

Échelle Grating Normal Plane
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Échelle Grating Normal Plane in the 
Label text field.

3 Locate the Plane Definition section. From the Plane type list, choose Transformed.

4 From the Work plane to transform list, choose 
Post Gamma Échelle Facet Tangent Plane (wp2).

5 Find the Rotation subsection. From the Axis type list, choose xw-axis.

6 In the Rotation angle text field, type theta_B-90. The échelle blaze angle is theta_B.

White Pupil
In this type of échelle spectrograph a "white pupil" is created at the location where the 
chief rays of all wavelengths in all orders most nearly intersect.

White Pupil Plane
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type White Pupil Plane in the Label text field.

3 Locate the Plane Definition section. From the Plane type list, choose Transformed.

4 Find the Displacement subsection. In the xw text field, type -dx_2.

5 Find the Rotation subsection. From the Axis type list, choose yw-axis.
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6 In the Rotation angle text field, type 4*gamma_ech. The rotation adjustment ensures 
that the central wavelength will be imaged onto the center of the image plane.

Cross Dsipersion
The plane of cross dispersion is defined with respect to the white pupil. In this example, 
the grating is oriented symmetrically between the White Pupil and Camera planes. That is, 
it bisects the angle formed by these two planes.

Cross Dispersion Plane
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Cross Dispersion Plane in the Label text 
field.

3 Locate the Plane Definition section. From the Plane type list, choose Transformed.

4 From the Work plane to transform list, choose White Pupil Plane (wp4).

5 Find the Displacement subsection. In the zw text field, type Z_xdp. This displacement 
ensures that the white pupil is located inside the Petzval lens where it more nearly 
coincides with the stop.

6 Find the Rotation subsection. From the Axis type list, choose yw-axis.

7 In the Rotation angle text field, type -theta_xdp.

Camera
This plane is used to orient the objective lens.

Camera Plane
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Camera Plane in the Label text field.

3 Locate the Plane Definition section. From the Plane type list, choose Transformed.

4 From the Work plane to transform list, choose Cross Dispersion Plane (wp5).

5 Find the Rotation subsection. From the Axis type list, choose yw-axis.

6 In the Rotation angle text field, type -theta_xdp.

The following commands are used to create the optical elements using various Part 

Instances, each of which will be positioned using these Work Planes.

Mirrors
Two off axis paraboloids are used, first to collimate the light from the entrance slit, and 
then subsequently, to relay the dispersed beam onto the location of the white pupil.
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Primary Mirror
1 In the Geometry toolbar, click Parts and choose Conic Mirror Off Axis 3D.

2 In the Settings window for Part Instance, type Primary Mirror in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the Displacement subsection. 
In the zw text field, type f_1.

Secondary Mirror
1 In the Geometry toolbar, click Parts and choose Conic Mirror Off Axis 3D.

2 In the Settings window for Part Instance, type Secondary Mirror in the Label text field.

Name Expression Value Description

R -2*f_1 -1600 mm Radius of curvature (+convex/-
concave)

k -1 -1 Conic constant

Tc Tc_OAP_1 30.833 mm Center thickness

d0 d0_OAP_1 185 mm Mirror full diameter

d_clear dc_OAP_1 175.75 mm Clear aperture diameter

dx dx_1_nom 123.48 mm Mirror off axis distance

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz 1 1 Local optical axis, z-component

nxx 1 1 Mirror off axis direction, x 
component

nxy 0 0 Mirror off axis direction, y 
component

nxz 0 0 Mirror off axis direction, z 
component

mtype 1 1 Mirror type (standard [0] or 
standalone [1])

show_vertex 0 0 Show mirror vertex (off [0] or on 
[1])

n_extra_r 0 0 Number of extra radial points

n_extra_a 0 0 Number of extra azimuthal points
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3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the Displacement subsection. 
In the zw text field, type -f_2.

Échelle and Cross Dispersion Gratings
The gratings are defined using the custom Grating part instance.

Échelle Grating
1 In the Geometry toolbar, click Parts and choose Grating.

2 In the Settings window for Part Instance, type Échelle Grating in the Label text field.

3 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Work plane list, choose 
Échelle Grating Normal Plane (wp3).

Name Expression Value Description

R -2*f_2 -800 mm Radius of curvature (+convex/-
concave)

k -1 -1 Conic constant

Tc Tc_OAP_2 20.833 mm Center thickness

d0 d0_OAP_2 125 mm Mirror full diameter

d_clear dc_OAP_2 118.75 mm Clear aperture diameter

dx dx_2_nom 34.506 mm Mirror off axis distance

nix 0 0 Local optical axis, x-component

niy 0 0 Local optical axis, y-component

niz -1 -1 Local optical axis, z-component

nxx -1 -1 Mirror off axis direction, x 
component

nxy 0 0 Mirror off axis direction, y 
component

nxz 0 0 Mirror off axis direction, z 
component

mtype 0 0 Mirror type (standard [0] or 
standalone [1])

show_vertex 0 0 Show mirror vertex (off [0] or on 
[1])

n_extra_r 0 0 Number of extra radial points

n_extra_a 0 0 Number of extra azimuthal points
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4 Locate the Input Parameters section. In the table, enter the following settings:

Cross Dispersion Grating Entrance
1 In the Geometry toolbar, click Parts and choose Grating.

2 In the Settings window for Part Instance, type Cross Dispersion Grating Entrance 
in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Work plane list, choose 
Cross Dispersion Plane (wp5).

5 Find the Rotation subsection. In the Rotation angle text field, type 90. This rotation 
ensures that the direction of cross dispersion is orthogonal to the échelle dispersion 
direction.

Cross Dispersion Grating Exit
1 In the Geometry toolbar, click Parts and choose Grating.

2 In the Settings window for Part Instance, type Cross Dispersion Grating Exit in 
the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

W W_ech 105 mm Grating Width

D D_ech 420 mm Grating Depth

H H_ech 42 mm Grating Height

Name Expression Value Description

W W_xdp 75 mm Grating Width

D D_xdp 62.5 mm Grating Depth

H H_xdp 7.5 mm Grating Height

Name Expression Value Description

W W_xdp 75 mm Grating Width

D D_xdp 62.5 mm Grating Depth

H H_xdp 7.5 mm Grating Height
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4 Locate the Position and Orientation of Output section. Find the 
Coordinate system to match subsection. From the Take work plane from list, choose 
Cross Dispersion Grating Entrance (pi4).

5 Find the Rotation subsection. From the Axis type list, choose yw-axis.

6 In the Rotation angle text field, type 180.

Petzval Lens Geometry Sequence
The objective lens used in the spectrograph can be inserted from file using a prepared 
geometry sequence. For detailed instructions on creating this geometry see the appendix 
of the Petzval Lens tutorial.

1 In the Geometry toolbar, click Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
white_pupil_echelle_spectrograph_petzval_lens_geom_sequence.mph.

Lens 1 (pi6)
1 In the Model Builder window, click Lens 1 (pi6).

2 In the Settings window for Part Instance, locate the Position and Orientation of Output 
section.

3 Find the Coordinate system to match subsection. From the Work plane list, choose 
Camera Plane (wp6).

4 Find the Displacement subsection. In the zw text field, type 30[mm].

Scale 1 (sca1)
Scale the Petzval Lens by a factor of 1.50 to increase the focal length from 100 mm to 150 
mm.

1 In the Geometry toolbar, click Transforms and choose Scale.

2 Select the objects pi10, pi11, pi12, pi13, pi14, pi15, pi6, pi7, pi8, and pi9 only. These 
objects are the lenses and apertures that form the Petzval lens. It is also possible to use 
the Paste Selection button to manually enter the list of object tags.

3 In the Settings window for Scale, locate the Scale Factor section.

4 In the Factor text field, type 1.50.

5 Locate the Coordinate System section. From the Take work plane from list, choose 
Lens 1 (pi6).

G L O B A L  D E F I N I T I O N S

Next, adjust a selection of the Petzval Lens geometry parameters. First, change the 
diameter of the Petzval Lens stop (d1_S). This accounts for the fact that the spectrograph’s 
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white pupil is not precisely located at this nominal location. We also adjust the position 
and curvature of the field flattening lens in order to minimize the RMS spot radius across 
the entire spectral format.

Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

W H I T E  P U P I L  É C H E L L E  G E O M E T R Y  S E Q U E N C E

Add the aperture stop selection to the rest of the camera obstructions.

Stop (pi8)
1 In the Model Builder window, under Component 1 (comp1)>

White Pupil Échelle Geometry Sequence click Stop (pi8).

2 In the Settings window for Part Instance, click to expand the Boundary Selections section.

3 In the table, enter the following settings:

Image (pi12)
Resize the focal plane to match the expected spectrum and modify the selection.

1 In the Model Builder window, click Image (pi12).

2 In the Settings window for Part Instance, locate the Input Parameters section.

Name Expression Value Description

d1_S 37.5[mm] 0.0375 m Stop clear diameter 
(adjusted)

T_5 46.819[mm] 0.046819 m L4 to L5 spacing (adjusted)

R1_6 -51.791[mm] -0.051791 m L5, surface 1 radius of 
curvature (adjusted)

T_6 1.900[mm] 0.0019 m L5 to detector spacing 
(adjusted)

Name Keep Physics Contribute to

All √ Obstructions
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3 In the table, enter the following settings:

4 Locate the Boundary Selections section. In the table, enter the following settings:

5 In the Geometry toolbar, click Build All.

6 Click the Go to ZX View button in the Graphics toolbar.

7 Click the Zoom Extents button in the Graphics toolbar. Orient the view to place the 
optical axis (z-axis) horizontal and the y-axis vertical. Compare the resulting image to 
Figure 2.

Cumulative Selections
Create a series of cumulative selections that can be used in the final ray tracing model.

Mirrors
1 In the Model Builder window, right-click Cumulative Selections and choose 

Cumulative Selection.

2 In the Settings window for Selection, type Mirrors in the Label text field.

Obstructions (Gratings and Mirrors)
1 In the Model Builder window, right-click Cumulative Selections and choose 

Cumulative Selection.

2 In the Settings window for Selection, type Obstructions (Gratings and Mirrors) 
in the Label text field.

Grating Material
1 Right-click Cumulative Selections and choose Cumulative Selection.

2 In the Settings window for Selection, type Grating Material in the Label text field.

Now, apply these selections.

Primary Mirror (pi1)
1 In the Model Builder window, click Primary Mirror (pi1).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

Name Expression Value Description

w0 20[mm] 20 mm Width, outer

h0 20[mm] 20 mm Height, outer

Name Keep Physics Contribute to

All √ √ None
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3 In the table, enter the following settings:

Secondary Mirror (pi2)
1 In the Model Builder window, click Secondary Mirror (pi2).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, enter the following settings:

Échelle Grating (pi3)
1 In the Model Builder window, click Échelle Grating (pi3).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, enter the following settings:

Cross Dispersion Grating Entrance (pi4)
1 In the Model Builder window, click Cross Dispersion Grating Entrance (pi4).

2 In the Settings window for Part Instance, click to expand the Domain Selections section.

Name Keep Physics Contribute to

Mirror surface √ Mirrors

Mirror obstruction √ Obstructions (Gratings and 
Mirrors)

Mirror rear surface √ Obstructions (Gratings and 
Mirrors)

Mirror edges √ Obstructions (Gratings and 
Mirrors)

Name Keep Physics Contribute to

Mirror surface √ Mirrors

Mirror obstruction √ Obstructions (Gratings and 
Mirrors)

Mirror rear surface √ Obstructions (Gratings and 
Mirrors)

Mirror edges √ Obstructions (Gratings and 
Mirrors)

Name Keep Physics Contribute to

Grating Surface √ √ None

Grating Obstruction √ Obstructions (Gratings and 
Mirrors)
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3 In the table, enter the following settings:

4 Locate the Boundary Selections section. In the table, select the Keep check boxes for 
Exterior and Grating Surface.

Cross Dispersion Grating Exit (pi5)
1 In the Model Builder window, click Cross Dispersion Grating Exit (pi5).

2 In the Settings window for Part Instance, locate the Domain Selections section.

3 In the table, enter the following settings:

4 Locate the Boundary Selections section. In the table, select the Keep check boxes for 
Exterior and Grating Surface.

All Refracting
1 In the Geometry toolbar, click Selections and choose Union Selection.

2 In the Settings window for Union Selection, type All Refracting in the Label text field.

3 Locate the Input Entities section. Click Add.

4 In the Add dialog box, in the Selections to add list, choose Grating Material and All Lenses.

5 Click OK.

Name Keep Physics Contribute to

All √ Grating Material

Name Keep Physics Contribute to

All √ Grating Material
34 |  W H I T E  P U P I L  É C H E L L E  S P E C T R O G R A P H


	White Pupil Échelle Spectrograph
	Introduction
	Model Definition
	Results and Discussion
	References
	Modeling Instructions
	Appendix — Geometry Instructions

